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chapter 1

MIDI I/O Introduction
About MIDI I/O
Congratulations on purchasing the Digidesign 
MIDI I/O USB (Universal Serial Bus) MIDI inter-
face for Windows and Macintosh.

MIDI I/O Capabilities

• Fully compatible with Pro Tools and other 
MIDI applications on Windows and Macin-
tosh

• Provides ten MIDI input and ten MIDI output 
ports for a total of 160 MIDI channels per in-
terface

• Up to four MIDI I/Os can be connected to-
gether for a total of 32 input ports and 40 out-
put ports (Windows), and 40 input and 
output ports (Macintosh)

• Powered from USB with a direct connection to 
your computer or a powered USB hub

• Supports MIDI Time Stamping 

• Supports programmable MIDI Thru mode 
when offline (not in use by a MIDI applica-
tion) or not connected to a computer

• Supports custom MIDI routing assignments 
for use in MIDI Thru mode
System Requirements
MIDI I/O requires the following:

• Digidesign-qualified computer running Win-
dows XP, Mac OS X, or Macintosh OS 9

– and –

• Pro Tools, or other compatible MIDI applica-
tions

For complete system requirements, visit the 
Digidesign Web site (www.digidesign.com).

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it 
has tested and approved. 

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, machine control-
lers and third-party devices, refer to the Digi-
design Web site (www.digidesign.com).
Chapter 1: MIDI I/O Introduction 1
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Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Session Choose Save Session 
from the File menu

Control+N Hold down the Control 
key and press the N key

Option-click Hold down the Option key 
and click the mouse but-
ton

Right-click (Windows) Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
the Pro Tools Guides.
MIDI I/O Guide
About www.digidesign.com
The Digidesign Web site (www.digidesign.com) 
is your best online source for information to 
help you get the most out of your Pro Tools sys-
tem. The following are just a few of the services 
and features available. 

Support Contact Digidesign Technical Support 
or Customer Service; download software up-
dates and the latest online manuals; browse the 
Compatibility documents for system require-
ments; search the online Answerbase or join the 
worldwide Pro Tools community on the Digi-
design User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from Digi-
design or sign up for a Pro Tools demo.

To learn more about these and other resources 
available from Digidesign, visit the Web site 
(www.digidesign.com). 



                
chapter 2

MIDI I/O Overview
This chapter explains all of the connectors and 
indicators on the front and back panels of the 
Digidesign MIDI I/O.

MIDI I/O Front Panel
The MIDI I/O has the following front panel 
ports and indicators, moving from left to right 
(see Figure 1):

MIDI In Ports 9 and 10

Connect individual MIDI devices such as MIDI 
keyboard controllers or MIDI control surfaces to 
the front panel MIDI In ports 9 and 10. This pro-
vides easy access for connecting MIDI devices 
even when the MIDI I/O is mounted in a rack.
MIDI Out Ports 9 and 10

Connect individual MIDI devices such as MIDI 
synthesizers or samplers to the front panel MIDI 
Out ports. The front panel MIDI Out ports mir-
ror the back panel MIDI Out ports 9 and 10. (A 
mirrored Out port simply means that it is a du-
plicated connector that transmits the same data 
as its front- or real-panel counterpart.) This pro-
vides easy access for connecting MIDI devices 
even when the MIDI I/O is mounted in a rack.

MIDI In Activity LED Indicators

The green MIDI In LED indicators display MIDI 
input activity by port (ports 1–10).

MIDI Out Activity LED Indicators

The yellow MIDI Out LED indicators display 
MIDI output activity by port (ports 1–10).
Figure 1.  Front panel of MIDI I/O

MIDI MIDI  IN
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IN 9 IN 10 OUT 9 OUT 10

MIDI  OUT PANIC/ RESET

MIDI IN
ports 9/10

MIDI OUT
ports 9/10

MIDI IN
LEDs

MIDI OUT
LEDs

Online
LED

Power
LED

Panic/Reset
button
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Online LED Indicator

The Online LED indicator lights when a MIDI 
application has been launched and recognizes 
the MIDI I/O. Once the Online LED is lit, MIDI 
Thru mode (see “MIDI Thru Mode” on page 26) 
is disabled.

Panic/Reset Button

Press the Panic/Reset button to send MIDI note 
off messages across all ports to turn off any hung 
notes on connected external MIDI devices. 

Press and hold the Panic/Reset button for at 
least three seconds (until the Power LED turns 
off) to reset the MIDI I/O. This causes the 
MIDI I/O’s driver to reload the current firmware 
and re-initialize the MIDI I/O. It has the same 
effect as disconnecting and then reconnecting 
the USB cable or external power supply. 

Power LED Indicator

The Power LED indicator lights when the 
MIDI I/O is powered on. The MIDI I/O can be 
powered by USB or by an optional external 
power supply. There is no On/Off switch on the 
MIDI I/O. The MIDI I/O is always on when it is 
receiving power, either from your computer 
over USB or from an external power supply.

Resetting the MIDI I/O when Pro Tools is 
running will cause it to go offline. You will 
need to restart Pro Tools to bring the 
MIDI I/O back online.
MIDI I/O Guide
MIDI I/O Back Panel
The MIDI I/O has the following back panel ports 
and connectors, moving from left to right (see 
Figure 2):

MIDI Out Ports 1 through 10

Connect individual MIDI devices to the back 
panel MIDI Out ports. MIDI data is sent from 
your computer to connected external MIDI de-
vices. Ports 9 and 10 are mirrored on the front 
panel of the MIDI I/O.

MIDI In Ports 1 through 8

Connect individual MIDI devices to the back 
panel MIDI In ports. MIDI data is sent from con-
nected external MIDI devices to your computer.

USB Port

Your computer communicates with the 
MIDI I/O through a USB cable connected to the 
MIDI I/O’s USB port and a USB port on your 
computer.
Figure 2.  Back panel of MIDI I/O

MIDI Out
ports 1–10

MIDI In
ports 1–8

USB
port

AC
Power



       
Alternate Power

If you want to use the MIDI I/O without con-
necting it to your computer, you can use any 
9–12 Volt DC power adapter, 500 mA 
(Tip +/Ring –) for power. When used in this way, 
the MIDI I/O will only function in MIDI Thru 
mode.

Typically, you will not need to use an external 
power supply when the MIDI I/O is connected 
to your computer, since the MIDI I/O is pow-
ered over USB from your computer. However, if 
you want to use the MIDI I/O in MIDI Thru 
mode without a computer, or if it is connected 
to an unpowered USB hub, you will need to use 
an external power supply.

LED Startup Sequence
The MIDI I/O’s internal firmware will load when 
the MIDI I/O is powered on (either from USB or 
an external power supply). You will see an LED 
startup sequence and the Power LED will light. 
This LED startup sequence indicates that the in-
ternal firmware has successfully loaded. When 
powered on, the MIDI I/O is in MIDI Thru 
mode.

Do not attempt to use one or more unpow-
ered MIDI I/O units on an unpowered USB 
hub.
Chapter 2: MIDI I/O Overview 5
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chapter 3

Windows Configuration
This chapter contains information for Windows 
systems only. If you are using the MIDI I/O with 
a Macintosh computer, see Chapter 4, “Macin-
tosh Configuration.”
Installing the MIDI I/O Drivers
To use the MIDI I/O with Pro Tools or other 
compatible MIDI applications, you will need to 
install the Digidesign MIDI USB Driver and the 
Digidesign MIDI I/O driver.

You will only need to run the Digidesign MIDI 
I/O Setup application once. After that, use the 
Hardware Wizard to set up any additional 
MIDI I/Os that are added later.

To install the MIDI I/O drivers:

1  Connect your MIDI I/O to any available USB 
port on your computer. See “Connecting USB” 
on page 8.

2  Launch the Digidesign MIDI I/O Setup appli-
cation from your Pro Tools Installer CD-ROM.

3  Follow the on-screen instructions.

4  Update the MIDI I/O Firmware. See “Updating 
MIDI I/O Firmware” on page 8.
Chapter 3: Windows Configuration 7
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Connecting USB

To connect the MIDI I/O to your computer:

1  Plug one end of the USB cable into the USB 
port on the MIDI I/O.

2  Plug the other end of the USB cable into any 
available USB port on your computer.

If you wish to use more than one MIDI I/O, each 
unit will need to be plugged into a separate USB 
port on your computer, or onto a powered USB 
hub. 

If your computer is powered on, MIDI I/O will 
receive power over the USB connection and you 
will see the LED startup sequence on the 
MIDI I/O’s front panel LEDs.

Updating MIDI I/O Firmware
Each release of the Digidesign MIDI I/O Setup 
application software includes the most current 
MIDI I/O firmware. 

To update the MIDI I/O firmware:

1  Choose Start > Control Panel. 

2  Launch System.

3  Click the Hardware tab.

4  Under Device Manager, choose Device Man-
ager.

5  In the Device Manager window, double-click 
Sound, video and game controllers, then dou-
ble-click your Digidesign MIDI I/O Interface.

Do not attempt to use one or more unpow-
ered MIDI I/O units on an unpowered USB 
hub.
MIDI I/O Guide
6  Click the Settings tab. The message “Firmware 
update necessary” is displayed underneath the 
Update Device Firmware button if the update is 
needed.

7  Click the Update Device Firmware button, if 
needed.

8  When the firmware update has completed, 
power cycle the MIDI I/O by disconnecting and 
reconnecting the USB cable and the optional ex-
ternal power cable. 

Firmware update necessary 

Firmware update not necessary 

If you’ve updated your firmware, and you 
also plan to use your MIDI I/O with a Mac-
intosh system as well as a Windows system, 
you will need to install the latest MIDI I/O 
driver for Macintosh OS X.



     
Connecting MIDI
Use standard MIDI cables to connect the 
MIDI I/O to your external MIDI devices. Con-
nect an Out port of the MIDI I/O to the In port 
of an external MIDI device; and connect an In 
port of the MIDI I/O to the Out port of an exter-
nal MIDI device. Typically, you will want to 
connect a single external MIDI device’s In and 
Out ports to the Out and In ports of the same 
number on the MIDI I/O. For example, you 
might connect the In and Out ports of your 
MIDI keyboard controller to Out port number 
10 and In port number 10, the In and Out ports 
of your MIDI control surface to Out port num-
ber 9 and In port number 9, and the In and Out 
ports of your MIDI tone generators and effects 
devices to Out ports number 1–5 and In ports 
number 1–5 (see Figure 3 on page 9).
Figure 3.  Connecting MIDI devices to MIDI I/O

MIDI MIDI  IN

1 2 3 4 5 6 7 8 9 10 ONLINE POWER1 2 3 4 5 6 7 8 9 10

IN 9 IN 10 OUT 9 OUT 10

MIDI  OUT PANIC/ RESET

PRE

MIDI In 1–5
MIDI Out 1–5

Digidesign MIDI I/O

MIDI control surface

MIDI keyboard

MIDI sound modules

Digidesign PRE or other
MIDI-controllable device
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Connecting Multiple MIDI I/Os

Up to four MIDI I/Os can be used together con-
nected to a single computer through a powered 
USB hub. To use more than one MIDI I/O in this 
way, connect your powered USB hub to any 
available USB port on your computer. Then, 
connect each MIDI I/O to available USB ports 
on the USB hub. Their Power LED indicators 
should light, indicating that each MIDI I/O is re-
ceiving power from the powered USB hub.

Matrix Routing

Using matrix routing, you can route the MIDI 
signal from a specified MIDI Input port to any of 
the MIDI Output ports on the MIDI I/O. Matrix 
routing is useful for configuring and testing 
your MIDI setup, configuring routing assign-
ments for MIDI I/O in MIDI Thru mode, and for 
playing any combination of your MIDI devices 
without launching Pro Tools.

To configure matrix routing:

1  Quit Pro Tools and any other MIDI applica-
tions.

2  Choose Start > Control Panel. 

3  Launch System.

4  Click the Hardware tab.

Due to Windows operating system limita-
tions, only 32 MIDI input ports are avail-
able when using four MIDI I/Os together. 
On the fourth MIDI I/O, only input ports 
one and two will be usable.

If you are using an unpowered USB hub, use 
an alternate power supply for each 
MIDI I/O (see “Insufficient USB Power” on 
page 27).
MIDI I/O Guide
5  Under Device Manager, choose Device Man-
ager.

6  In the Device Manager window, double-click 
Sound, video and game controllers, then dou-
ble-click your Digidesign MIDI I/O Interface.

7  Click the Settings tab.

8  Select the MIDI Input (Ports 1–10) whose rout-
ing you want to configure. You only configure 
the routing for a single input at a time.

9  Select the MIDI Outputs (Ports 1–10) to which 
you want the selected MIDI Input port routed. 

10  Repeat steps 8–9 for each input you wish to 
configure.

11  Click OK when finished to save the settings 
and close the MIDI I/O Interface Properties dia-
log.

The Matrix Routing settings are saved in the 
MIDI I/O, and will be recalled the next time you 
open the MIDI I/O Windows driver. 

MIDI I/O Interface Properties dialog (Settings tab)



Identify Device

If you are using more than one MIDI I/O, enable 
the Identify Device option to light the LEDs on 
the currently selected MIDI I/O.

Update Device Firmware

Lets you update the driver firmware. For more 
information, see “Updating MIDI I/O Firm-
ware” on page 8.

Device ID

The MIDI I/O driver software automatically as-
signs a Device ID number (from 1–4) to each in-
terface, which is displayed in the Device ID 
field. This gives each MIDI I/O a unique name 
that is visible in Pro Tools or other MIDI appli-
cations.

You can change the Device ID to any ID num-
ber, however you cannot use two MIDI I/Os 
with the same Device ID on the same computer. 

If you connect a MIDI I/O that has the same de-
vice ID as another currently connected 
MIDI I/O, the driver software will automatically 
change the Device ID of the newly connected 
MIDI I/O to the lowest available Device ID num-
ber.

Default Routing

Click the Default Routing button to return the 
MIDI routing to the default state. In the default 
routing state, MIDI information that is received 
in any input port is sent out to every output port 
except the output port with the same number.
MIDI Studio Setup
MSS (MIDI Studio Setup) lets you configure the 
MIDI controllers and sound modules that are 
connected to your system, and control the rout-
ing of MIDI data between your MIDI equipment 
and Pro Tools.

MSS automatically finds MIDI interfaces, and 
lets you specify a custom name for each of the 
MIDI ports within the MIDI studio setup docu-
ment. 

MSS also supports XML-based patch file names 
for storing and importing patch names for your 
external MIDI devices. 

Entire MIDI Studio Setup configurations created 
within MSS can be imported and exported. 

Internal MIDI ports, such as the Microsoft 
MIDI Mapper and built-in wavetable syn-
thesizers are filtered from the list of avail-
able MIDI output ports. They are, however, 
accessible directly from a MIDI track’s out-
put popup.
Chapter 3: Windows Configuration 11
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MIDI Studio Setup Window

The MIDI Studio Setup window is organized 
into three sections. Interface controls are at the 
top of the window. All the currently defined in-
struments are displayed in the Instrument 
Name list on the left side of the window. A de-
tailed view of MIDI parameters is shown in the 
Properties section on the right.

Create This button adds a new instrument to 
the Instrument Name list.

Delete This button deletes the instrument or in-
struments selected in the Instrument Name list.

Import This button lets you import existing 
MIDI studio setup files.

Export This button lets you export the current 
MIDI studio setup file.

Show Duplicate Emulated Outputs When the 
Show Duplicate Emulated Outputs option is se-
lected, the MIDI Studio Setup window shows 
both the DirectMusic output ports, and dupli-
cate emulated output ports. 

Instrument List

The Instrument list contains all the currently 
defined instruments. Selecting an instrument in 
the list displays that instrument’s properties in 
the properties section of the window.

MIDI Studio Setup window
MIDI I/O Guide
Properties Section

The Properties section lets you edit information 
for new instruments, or instruments currently 
displayed in the Instrument Name list.

When a previously defined instrument is se-
lected in the Instrument Name list, the Proper-
ties section changes to reflect the properties of 
the selected instrument.

To define an instrument with MIDI Studio Setup:

1  In Pro Tools, choose Setup > MIDI > MIDI Stu-
dio. The MIDI Studio Setup window opens.

2  Click Create.

3  In the Instrument Name field, type the name 
of your instrument, and press enter.

4  Set a manufacturer and model for the new de-
vice from the corresponding pop-up menus. If 
the Manufacturer and Model pop-up menus do 
not provide a name for your particular device, 
choose None.

5  From the Input pop-up menu, choose the in-
put port on your MIDI interface that is con-
nected to the MIDI Out of your instrument.

MIDI Studio Setup Properties section

If you do not enter an instrument name, the 
Instrument Name field will automatically 
inherit information from the Manufacturer 
and Model pop-up menu. 



6  From the Output pop-up menu, choose the 
output port on your MIDI interface that is con-
nected to the MIDI In of your instrument.

7  Enable the appropriate MIDI channels (1–16) 
for the Send Channels and Receive Channels 
options (These determine which channels send 
and receive MIDI.)

Instrument Name

The Instrument Name field shows the user-de-
finable instrument name for the currently se-
lected instrument.

Manufacturer

The Manufacturer pop-up menu provides a list 
of MIDI equipment manufacturers. This list is 
derived from the XML-based MIDI device files 
provided with your Pro Tools installation. 

Model

The Model pop-up menu provides a list of MIDI 
devices, filtered by the manufacturer name. This 
list is derived from the XML-based MIDI device 
files provided with your Pro Tools installation.

Input Port

The Input Port pop-up menu displays a list of 
available MIDI interface input ports. The MIDI 
interface port that is set and displayed here is 
the port through which MIDI data is sent from 
the external MIDI device specified in the Instru-
ment Name field into your MIDI interface.

Output Port

The Output Port pop-up menu displays a list of 
available MIDI interface output ports. The port 
set and displayed here is the port through which 
MIDI data is sent from your MIDI interface to 
the MIDI device specified in the Instrument 
Name field.
Send Channels

The Send Channels grid sets the send channels 
for the MIDI device specified in the Instrument 
Name field. 

Receive Channels

The Receive Channels grid sets the receive chan-
nels for the MIDI device specified in the Instru-
ment Name field.
Chapter 3: Windows Configuration 13
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chapter 4

Macintosh Configuration
This chapter explains how to install, connect, 
and configure the MIDI I/O for use with your 
Macintosh computer. If you are using the MIDI 
I/O with a Windows computer, see Chapter 3, 
“Windows Configuration.”

Mac OS X Users

To configure and manage your MIDI setup on 
Mac OS X v10.2.3 or later, you will use the Au-
dio MIDI Setup utility (AMS) installed with the 
system software (in /Applications/Utilities/).

Mac OS 9 Users

To configure and manage your MIDI setup on 
Mac OS 9, you will use Open Music System 
(OMS) 2.3.8, which is included on the MIDI I/O 
installer CD-ROM. 

Mac OS 9 users must install OMS before 
proceeding to the next section and installing 
the MIDI I/O Drivers. See “Installing OMS” 
on page 21 for instructions.
Installing the MIDI I/O Drivers
To use the MIDI I/O with Pro Tools or other 
compatible MIDI applications, you will need to 
install the Digidesign MIDI USB Driver and the 
Digidesign MIDI driver.

To install the MIDI I/O drivers:

1  Insert the MIDI I/O Installer CD-ROM into 
your CD-ROM drive and launch the Install ap-
plication.

2  Follow the on-screen instructions.

When the installation is finished, restart your 
computer. Proceed by connecting the MIDI I/O 
to your computer with the provided USB cable.

Do not connect the USB cable to the 
MIDI I/O until after you have installed the 
drivers for MIDI I/O. MIDI I/O will not ini-
tialize correctly if you connect the USB cable 
before installing the drivers.

Before using the MIDI I/O with Mac OS X, 
launch the MIDI I/O Firmware Updater ap-
plication (in Applications/Digidesign/
MIDI IO). 
Chapter 4: Macintosh Configuration 15
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Mac OS 9 Users

If you want to use the MIDI I/O with both 
Mac OS 9 and Mac OS X (for example, running 
Pro Tools 5.x with OS 9 and Pro Tools 6.x or 
later with OS X) you must use version 1.5 of the 
MIDI I/O driver. 

This driver is installed when running the 
MIDI I/O Installer under Mac OS 9.

To confirm that version 1.5 of the MIDI I/O driver 
has been installed:

1  When booted into OS 9, open your System Ex-
tensions folder (System Folder/Extensions).

2  Locate the Digidesign MIDI USB Driver Exten-
sion and confirm that the version number is 1.5.

Connecting USB

To connect the MIDI I/O to your computer:

1  Plug one end of the USB cable into the USB 
port on the MIDI I/O.

2  Plug the other end of the USB cable into any 
available USB port on your computer.

Connecting a USB cable to a Macintosh
MIDI I/O Guide
If your computer is powered on, MIDI I/O will 
receive power over the USB connection and you 
will see the LED startup sequence on the 
MIDI I/O’s front panel LEDs.

Connecting MIDI
Use standard MIDI cables to connect the 
MIDI I/O to your external MIDI devices. Con-
nect an Out port of the MIDI I/O to the In port 
of an external MIDI device; and connect an In 
port of the MIDI I/O to the Out port of an exter-
nal MIDI device. Typically, you will want to 
connect a single external MIDI device’s In and 
Out ports to the Out and In ports of the same 
number on the MIDI I/O. For example, you 
might connect the In and Out ports of your 
MIDI keyboard controller to Out port number 
10 and In port number 10, the In and Out ports 
of your MIDI control surface to Out port num-
ber 9 and In port number 9, and the In and Out 
ports of your MIDI tone generators and effects 
devices to Out ports number 1–5 and In ports 
number 1–5 (see Figure 4 on page 17).



Figure 4.  Connecting MIDI devices to MIDI I/O
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MIDI keyboard

MIDI sound modules

Digidesign PRE or other
MIDI-controllable device
Connecting Multiple MIDI I/Os

Up to four MIDI I/Os can be used together con-
nected to a single computer through a powered 
USB hub. To use more than one MIDI I/O in this 
way, connect your powered USB hub to any 
available USB port on your computer. Then, 
connect each MIDI I/O to available USB ports 
on the USB hub. Their Power LED indicators 
should light, indicating that each MIDI I/O is re-
ceiving power from the powered USB hub.
The Audio MIDI Setup utility (Mac OS X users) 
or OMS Setup application (Mac OS 9 users) will 
need to be configured to use all connected 
MIDI I/Os. See “Configuring Audio MIDI Setup” 
on page 18 and “Configuring OMS” on page 21.

If you are using an unpowered USB hub, use 
an alternate power supply for each 
MIDI I/O (see “Insufficient USB Power” on 
page 27).
Chapter 4: Macintosh Configuration 17
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Configuring Audio MIDI Setup
(Mac OS X Only)

If your computer is running Mac OS X v10.2.3 
or later, you will use the Audio MIDI Setup util-
ity (in /Applications/Utilities/) to configure the 
MIDI I/O.

To configure the MIDI I/O in AMS:

1  Launch Audio MIDI Setup (in Applica-
tions/Utilities/).

– or –

In Pro Tools, choose Setup > MIDI > MIDI Setup.

2  Select the MIDI Devices tab. AMS will scan 
you system for connected MIDI interfaces. If 
your MIDI I/O is properly connected, it will ap-
pear in the window with each of its ports num-
bered.

3  For any MIDI devices connected to the 
MIDI I/O, click Add Device. A new external de-
vice icon with the default MIDI keyboard image 
will appear.

4  Drag the new device icon to a convenient lo-
cation within the window.

Audio MIDI Setup (MIDI Devices tab)
MIDI I/O Guide
5  Connect the MIDI device to the MIDI I/O by 
clicking the arrow for the appropriate output 
port of the device and dragging a cable to the in-
put arrow of the corresponding port of the 
MIDI I/O.

6  Click the arrow for the appropriate input port 
of the device and drag a cable to the output ar-
row of the corresponding port of the MIDI I/O. 

7  Repeat steps 3–6 for each MIDI device in your 
MIDI setup.

The MIDI I/O supports up to 10 MIDI devices at 
the same time. If you use multiple MIDI devices, 
make sure that none of them are assigned to the 
same MIDI input port and channel.

To configure an external MIDI device:

1  Select the external device icon and click Show 
Info (or double-click the new device icon). 

Making MIDI input and output connections

To remove a connection, select the cable and 
press the Delete key. To delete all cables, 
click Clear Cables.

External Device Icon



2  Select a manufacturer and model for the new 
device from the pop-up menus. (If the Manufac-
turer and Model pop-up menus do not provide a 
name for your particular device, manually type 
its name.)

3  Click the More Properties arrow to expand the 
dialog, then enable the appropriate MIDI chan-
nels (1-16) for the Transmits and Receives op-
tions. (These determine on which channels the 
device will send and receive MIDI.) 

Naming a new MIDI device

Enable Receive and Transmit MIDI Channels
4  To select an icon for the device, click the im-
age (the window expands to show images for 
various MIDI devices such as keyboards, mod-
ules, interfaces, and mixers) and select the de-
sired icon.

5  Click OK when you are done.

6  Quit Audio MIDI Setup when finished.

Selecting a device icon

To use your own custom icons, place tiff im-
age files in /Library/Audio/MIDI Devices/
Generic/Images.
Chapter 4: Macintosh Configuration 19
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Matrix Routing

Using matrix routing, you can route the MIDI 
signal from a specified MIDI Input port to any of 
the MIDI Output ports on the MIDI I/O. Matrix 
routing is useful for configuring and testing 
your MIDI setup, configuring routing assign-
ments for MIDI I/O in MIDI Thru mode, and for 
playing any combination of your MIDI devices 
without launching Pro Tools.

To configure matrix routing:

1  Launch the MIDI I/O Setup utility.

2  If you are using more than one MIDI I/O, se-
lect the correct MIDI I/O from the MIDI Inter-
face pop-up menu.

3  Select the MIDI Input (Ports 1–10) whose rout-
ing you want to configure. You can only config-
ure the routing for a single input at a time.

4  Select the MIDI Outputs (Ports 1–10) to which 
you want the selected MIDI Input port routed. 

MIDI I/O Setup utility (Matrix Routing tab)

No matter how many MIDI I/Os are con-
nected to your computer, the MIDI Interface 
pop-up menu will always list Device 1–4.
MIDI I/O Guide
5  Click the Save Routing to Device button if you 
want to save the routing assignments for the 
currently selected MIDI Input port to the 
MIDI I/O for use in MIDI Thru mode.

6  Quit the MIDI I/O Setup utility when fin-
ished.

The Matrix Routing settings will be recalled the 
next time you open the MIDI I/O Setup utility 

MIDI Interface Pop-Up Menu

If you are using more than one MIDI I/O, use 
the MIDI Interface pop-up menu to select the 
specific MIDI I/O whose routing assignments 
you want to configure.

Identify Device

If you are using more than one MIDI I/O, enable 
the Identify Device option to light the LEDs on 
the MIDI I/O currently selected in the MIDI In-
terface pop-up menu.

Save Routing To Device

Click the Save Routing to Device button to save 
the routing assignments for the currently se-
lected MIDI Input port to the MIDI I/O for use 
in MIDI Thru mode. Each MIDI Input port’s 
routing assignments will need to be saved to the 
MIDI I/O independently.

Default Routing

Click the Default Routing button to deselect all 
MIDI Outputs for the currently selected MIDI 
Input.



Installing OMS
(Mac OS 9 Only)

If your computer is running Mac OS 9.2.x or 
earlier, use Open Music System (OMS) 2.3.8 to 
configure the MIDI I/O.

If you have not already installed OMS, please do 
so now.

OMS, which is included on the MIDI I/O In-
staller CD-ROM, has the following capabilities:

• Keeps track of which MIDI devices you are us-
ing, how they are connected, and which 
patches they are using

• Enables MIDI hardware to communicate with 
your music applications

• Provides timing services and inter-application 
communication

OMS stores a description of your MIDI studio in 
Studio Setup documents, which are edited in the 
OMS Setup application. Once OMS is configured, 
your music applications know which MIDI de-
vices you are using by referencing the current 
Studio Setup document.

The following section provides basic instruc-
tions for installing OMS. For OMS configuration 
steps, see “Configuring OMS” on page 21. For 
additional information, refer to the online OMS 
Guide installed with Pro Tools.
Installing OMS

The OMS Installer is located on your MIDI I/O 
Installer CD-ROM. If OMS is already installed on 
your system, skip to “Installing the MIDI I/O 
Drivers” on page 15.

To install OMS:

1  Insert the MIDI I/O Installer CD-ROM into 
your CD-ROM drive. 

2  Open the OMS Installer folder and double-
click the Installer.

3  At the Install window, select the Easy Install 
option, and set the Install Location to your star-
tup hard drive. Click Install.

4  Follow the on-screen installation instructions.

5  When the installation is complete, restart 
your Macintosh.

You are now ready to install the USB and OMS 
drivers for the MIDI I/O.

Configuring OMS

To use the MIDI I/O with Pro Tools or other 
OMS-compatible MIDI applications, you will 
need to configure OMS after you have installed 
the Digidesign MIDI OMS Driver.

When launching Pro Tools or OMS Setup for the 
first time, the OMS software will prompt you to 
create a new studio setup if OMS was not previ-
ously configured. OMS can also be reconfigured 
by launching the OMS Setup application (from 
your OMS folder).

Before configuring OMS, make sure you have in-
stalled the MIDI I/O’s USB and OMS drivers (see 
“Installing the MIDI I/O Drivers” on page 15) 
and that your MIDI I/O and devices are properly 
connected (see “Connecting MIDI” on page 16).
Chapter 4: Macintosh Configuration 21
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To configure a New Studio Setup in OMS:

1  When prompted to configure a New Studio 
Setup, click OK.

2  Since the MIDI I/O is a USB device, leave both 
ports unchecked and click Search.

OMS searches for and displays any detected 
MIDI interfaces, MIDI cards, and OMS drivers. If 
the MIDI I/O is not detected, click Trouble-
shoot. Once your MIDI I/O is detected, you are 
prompted to search for MIDI instruments con-
nected to your interface.

3  Click OK to search for MIDI devices connected 
to your MIDI I/O. To be detected, the device 
must be turned on and have both of its MIDI 
ports connected to your MIDI I/O.

Ports for OMS Driver Search

OMS Driver Setup
MIDI I/O Guide
OMS searches for and displays any detected 
MIDI devices. Some older instruments, as well as 
some newer ones, may not be recognized by the 
OMS auto-detection routines. 

Devices not recognized by OMS appear with a 
red question mark and are named based on the 
interface or port to which they are connected. 
These devices can be defined as necessary within 
the OMS Setup application (see “Defining MIDI 
Devices in OMS” on page 23).

4  Click OK to save your Studio Setup document.

5  Quit OMS Setup.

Undefined OMS device

Studio Setup window



Defining MIDI Devices in OMS

To define a MIDI device in OMS Setup:

1  Double-click the device’s icon in the Studio 
Setup window.

2  In the MIDI Device Info dialog, select the 
Manufacturer and Model for the device from the 
pop-up menus. If the device is not listed, leave 
the Model set to “other” and enter a name for 
the device.

3  Select the receiving channel for the device. If 
receiving multiple channels, select the option 
for “Is Multitimbral.”

4  If you will record from the device in Pro Tools, 
select the option for “Is Controller.” 

5  If the device will be a source or destination for 
MIDI Time Code, Beat Clock, or MMC, select 
the appropriate option. 

6  Click OK.

Defining a MIDI device
Disabling SerialDMA in OMS

Pro Tools requires that you deselect the “Use 
Apple SerialDMA Driver When Available” op-
tion in OMS Setup. If you do not disable this op-
tion, problems will occur with MIDI and syn-
chronization functions in Pro Tools. 

To disable SerialDMA in OMS:

1  Double-click the OMS Setup application.

2  Choose Edit > Preferences.

3  Deselect “Use Apple SerialDMA Driver When 
Available,” and click OK.

4  Quit OMS Setup.

5  Restart your computer.

MIDI I/O OMS Menu

Once you have installed the Digidesign MIDI 
USB Driver and the Digidesign MIDI OMS 
Driver, and you have configured your OMS 
Setup, the MIDI I/O menu will be available in 
OMS Setup. The MIDI I/O menu provides access 
to the MIDI I/O Matrix Mode and Test MIDI Ca-
ble dialogs.

Matrix Mode

Using Matrix mode, you can route the MIDI sig-
nal from a specified MIDI Input port to any of 
the MIDI Output ports on the MIDI I/O. Matrix 
mode is useful for configuring and testing your 
MIDI setup, configuring routing assignments 
for MIDI I/O in MIDI Thru mode, and for play-
ing any combination of your MIDI devices with-
out launching Pro Tools.

If the MIDI I/O menu does not appear in 
OMS Setup, quit and re-launch OMS Setup.

Matrix mode is active only when the Matrix 
Mode dialog is open.
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To configure MIDI routing in Matrix mode:

1  In OMS Setup, choose Digi MIDI I/O > Matrix 
Mode to open the MIDI Routing Assignments 
dialog.

2  If you are using more than one MIDI I/O, se-
lect the correct MIDI I/O from the MIDI Inter-
face pop-up menu.

3  Select the MIDI Input (Ports 1–10) whose rout-
ing you want to configure. You can only config-
ure the routing for a single input at a time.

4  Select the MIDI Outputs (Ports 1–10) to which 
you want the selected MIDI Input port routed. 

5  Click the Save Routing to Device button if you 
want to save the routing assignments for the 
currently selected MIDI Input port to the 
MIDI I/O for use in MIDI Thru mode.

6  Click Done to close the MIDI Routing Assign-
ments dialog.

The settings for the MIDI Matrix dialog will be 
stored in the MIDI I/O Preferences file, so that 
the last settings will be recalled the next time 
you open the MIDI Matrix dialog

MIDI Routing Assignments dialog

No matter how many MIDI I/Os you have 
connected to your computer, the MIDI Inter-
face pop-up menu will always list Device 
1–4.
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MIDI Interface Pop-Up Menu

If you are using more than one MIDI I/O, use 
the MIDI Interface pop-up menu to select the 
specific MIDI I/O whose routing assignments 
you want to configure.

Identify Device

If you are using more than one MIDI I/O, enable 
the Identify Device option to light the LEDs on 
the MIDI I/O currently selected in the MIDI In-
terface pop-up menu.

Save Routing To Device

Click the Save Routing to Device button to save 
the routing assignments for the currently se-
lected MIDI Input port to the MIDI I/O for use 
in MIDI Thru mode. Each MIDI Input port’s 
routing assignments will need to be saved to the 
MIDI I/O independently.

Default Routing

Click the Default Routing button to deselect all 
MIDI Outputs for the currently selected MIDI 
Input.



chapter 5

Basic Use
Using the MIDI I/O with 
Pro Tools
Once you have made all the connections be-
tween your computer, MIDI I/O, and all exter-
nal MIDI devices, and you have installed the 
MIDI I/O’s USB and MIDI drivers, and config-
ured MSS, AMS, or OMS, you are ready to use the 
MIDI I/O with Pro Tools.

MIDI Time Stamping

The MIDI I/O is equipped with MIDI Time 
Stamping capabilities. MIDI Time Stamping 
achieves MIDI playback timing with better than 
1 millisecond accuracy. Every MIDI event is 
“time-stamped,” meaning that every MIDI 
event is grouped with its time and then sent in 
packages ahead of time, rather than serially. 
MIDI Time Stamping provides unprecedented 
MIDI timing accuracy for better sounding re-
sults.

For more detailed information about using 
MIDI in Pro Tools, see the Pro Tools Refer-
ence Guide.
Using the MIDI I/O in MIDI 
Thru Mode
The MIDI I/O can be used in MIDI Thru mode as 
a stand-alone interface to control multiple MIDI 
devices from a single MIDI controller. 

To use the MIDI I/O as a stand-alone MIDI inter-
face, the MIDI I/O needs to be powered in one of 
the following ways:

• Connect MIDI I/O to a computer that is 
powered on.

• Connect MIDI I/O to a powered USB hub.

• Connect MIDI I/O to an external power 
supply (9–12 Volts DC, 500 mA; Polarity: 
Tip = Plus, Ring = Minus).
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MIDI Thru Mode

The MIDI I/O supports MIDI Thru mode when it 
is offline—not engaged by a MIDI application 
on the computer to which it is connected. The 
Online LED indicator will not be lit when the 
MIDI I/O is offline. 

To use the MIDI I/O in MIDI Thru mode:

1  Supply power to the MIDI I/O (from a com-
puter, powered USB hub, or a qualified external 
power supply.

2  Connect the MIDI Out port of your MIDI con-
troller device (such as a MIDI keyboard control-
ler) to any MIDI In port on the MIDI I/O.

3  Connect the other MIDI Out ports of the 
MIDI I/O to the MIDI In ports of the MIDI de-
vices you want to control.

The MIDI I/O will operate in MIDI Thru mode.

By default, MIDI Thru mode automatically 
routes all MIDI In ports to all MIDI Out ports, 
except the same port to prevent feedback loops. 
For example, MIDI In port 1 is routed to MIDI 
Out ports 2–10, MIDI In port 2 is routed to MIDI 
Out ports 1 and 3–10, and so on. 

You can configure your own routing assign-
ments using the Matrix Routing settings in the 
Windows MIDI I/O driver, the Matrix Routing 
settings in the MIDI I/O setup utility under 
Mac OS X, and Matrix mode under OMS in 
Mac OS 9.

For more information, see“Matrix Routing” 
on page 10, “Matrix Routing” on page 20, 
or “Matrix Mode” on page 23.
MIDI I/O Guide



appendix a

Troubleshooting
LEDs Do Not Light When Powered On

When the MIDI I/O is receiving power, the 
Power LED will be lit. If the Power LED is off, 
double check the USB cable (which is providing 
power from you computer) or power supply, 
and re-initialize the interface by disconnecting 
and reconnecting the USB cable or power sup-
ply. You can also use the Panic/Reset switch on 
the front panel of MIDI I/O (be sure to press and 
hold the switch for at least three seconds until 
the power LED turns off or MIDI I/O will not re-
set itself). When re-attaching the USB cable or 
external power supply, you should see a short 
LED startup sequence and the Power LED turns 
on.

If you don’t see this LED startup sequence, the 
MIDI I/O is either not receiving sufficient power 
or there may be a problem with your unit. Please 
re-check power requirements and if problems 
persist, contact Digidesign Technical Support.
Insufficient USB Power

If you are trying to use a MIDI I/O with another 
USB device on a single USB port, there will not 
be enough power and the operating system will 
warn you that you have insufficient power. In 
some cases, this can also cause an operating sys-
tem crash.

Insufficient USB Power dialog (Macintosh)

Insufficient USB Power dialog (Windows)
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There are two solutions to this problem:

• Connect an external power supply to 
MIDI I/O. Be sure to check voltage and polar-
ity on the back panel of MIDI I/O.

– or –

• Connect one or more MIDI I/O units to a 
powered USB hub; do not attempt to use a 
non-powered hub, it will not work without 
using an external power supply for each 
MIDI I/O. Powered USB hubs have their own 
power supply and provide 500 mA on all 
downstream USB connectors, providing am-
ple power to each MIDI I/O.

Do not attempt to use one or more unpow-
ered MIDI I/O units on an unpowered USB 
hub.
MIDI I/O Guide
MIDI I/O OMS Menu Not Available

(Mac OS 9 Only)

When you launch the OMS Setup application, 
OMS builds the MIDI I/O menu only if it finds 
one or more MIDI I/Os connected and declared 
in the currently active OMS Studio Setup.

If you don't see the MIDI I/O menu, check the 
following: 

• Make sure that MIDI I/O is connected to USB. 

• Check that the Online LED turns on when 
launching OMS. 

• If your currently active OMS setup document 
may not have MIDI I/O declared, please scan 
for connected MIDI interfaces by choosing 
Setup > MIDI Cards & Interfaces, or create a 
new setup document by choosing File > New 
Studio Setup.

You will have to quit and re-launch OMS Studio 
Setup for the changes to take effect.
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